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Customer Support 

 
Renewable NRG Systems offers a variety of support options to help you get the most from your RNRG product. 
If you have questions about your RNRG product, first look in the product documentation or the Knowledge 
Base or Technical Forum in the Tech Support section of the Renewable NRG Systems web site 
(www.renewablenrgsystems.com/technical-support). If you cannot find the answer, contact your salesperson 
or Renewable NRG Systems Technical Support for assistance using the information below. Customer support is 
available 8:30 AM to 5:00 PM EST, Monday through Friday. 
 
Renewable NRG Systems 
110 Riggs Road 
Hinesburg, Vermont 
05461 U.S.A. 
 
Telephone: 802-482-2255 ext. 3 
Fax: 802-482-2272 
Email: support@renewablenrgsystems.com 
 
When you call or email, please have the appropriate product documentation at hand and be prepared to give 
the following information: 

 Customer name 

 Who purchased equipment 
 Item number or description 

 Serial numbers of loggers and iPack equipment 
 When equipment was purchased 
 Where equipment is installed - terrain conditions 
 Description of the problem with some detail 
 What events took place leading up to the problem 

 What you have tried while attempting to solve the problem 
  

You may be asked to provide data files or other information to help us investigate an issue. All information and 
data provided are kept strictly confidential. 
 
Renewable NRG Systems maintains an extensive website which includes an in-depth customer support area. If 
you need assistance at times other than our regular business hours, we suggest visiting our website, 
www.renewablenrgsystems.com. 
 
All instruments, sensors, software and towers manufactured by Renewable NRG Systems are designed to be 
reliable and easy to use. We welcome your comments and appreciate your help in making our products the 
best available. 

http://www.renewablenrgsystems.com/technical-support
file:///C:/Users/jma/Documents/SharePoint%20Drafts/web/Dept/Quality/Customer%20Documents/support@renewablenrgsystems.com
http://www.renewablenrgsystems.com/
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Introduction 

Congratulations on your purchase of the Symphonie iPackACCESS.  SymphoniePLUS3 stores ten-minute 
statistical data for wind resource assessment on a standard SD card and makes available real time data 
through the iPackACCESS.  The iPackACCESS is designed to be used in an industrial communications network. 
The iPackACCESS will act as a server using the MODBUS protocol to send data to a client.  MODBUS is a 
master-slave protocol. The MODBUS client will send a request, and the iPackACCESS will act on the request 
and send a response. 
 
The SymphoniePLUS3’s standard 10-minute averaged data stream can also be transmitted by the iPackACCESS 
over the dedicated network connection (instead of cellular connection like the iPackGPS).  

Using This Manual 

The iPackACCESS manual assumes the user is familiar with programming, grounding, connection, and 
installation of the SymphoniePLUS3 logger, iPackGPS, and the Symphonie Data Retriever software.  More 
detailed information can be found in the SymphoniePLUS3 manual, available here: 
 
http://www.nrgsystems.com/TechSupport/Documentation.aspx 
 
iPackACCESS configuration for transmission of SymphoniePLUS3 daily wind resource assessment files is 
described in a separate chapter from the MODBUS configuration. 
 
This document and the instruments described herein may use the following symbols: 
 

 Earth (Ground)   Read the Manual   DC Voltage 

Definitions 

This type style is used for the general body of this manual and is used for general descriptions and instructions 
to the user.  

 
Instructions in Bold Type refer to Symphonie Data Retriever Software and require you to press a button on 
the computer screen, open a file, or select from a program menu.  For example:  File>Open. 

 
Instructions in [Brackets] refer to SymphoniePLUS3 logger keypad navigation and require you to press a 
series of keys to perform a specific function.  For example, pressing the [Home/Esc] key will always return 
the display to the Main Menu. 

 

This type style is used to show actual prompts and messages that appear on the logger display. 

 

This type style is used to warn users of a potential danger, either to themselves or to the equipment or data.  
  

http://www.nrgsystems.com/TechSupport/Documentation.aspx
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Theory of Operation 

Real-time (one-second) data are collected from each of SymphoniePLUS3’s 15 channels. Raw and scaled data 
are made available to the SCADA system through the MODBUS TCP protocol to help wind farm operators 
analyze the performance of turbines within a wind farm.  Statistical forecasting data (average, standard 
deviation, minimum, maximum) at a user-specified interval are also available through the MODBUS TCP 
protocol for analysis by wind farm operators and for delivery to a forecasting service provider.   Ten-minute 
data are available for validation of the wind resource via email delivery over the SCADA network’s internet 
connection or by manually pulling the SD card from the data logger.  
 

 
 
 



Introduction 

 
 

iPackACCESS_Manual     |     Rev 4     |     1 May 2015     |     support@renewableNRGsystems.com     ||     11 

 

 
The iPackACCESS was developed to make available three data streams from the SymphoniePLUS3 data 
logger: 
 

o Real-time data provides one-second samples that are made available to the SCADA system 
through the MODBUS TCP protocol. These raw and scaled data are pulled from the 
iPackACCESS to help wind farm operators analyze the performance of turbines within a wind 
farm.  
 

 
o Statistical data provides average, standard deviation, minimum, and maximum values at 

user-specified intervals (1, 2, 5, 10, 15, 30, and 60 minutes) through the MODBUS TCP 
protocol. This data is pulled from the iPackACCESS for analysis by wind farm operators and 
forecasting service providers to predict the future energy production of a wind farm through the 
use of a wind forecast model.  
 
 

o Wind resource assessment data is the ten-minute average data collected during a wind 
measurement campaign prior to the development of the wind farm. This data is available via 
email delivery over the SCADA network’s internet connection or by manually pulling the SD card 
from the data logger to validate the wind resource after a wind farm becomes operational.  

iPackACCESS 

 
The iPackACCESS makes the SymphoniePLUS3’s real time raw and scaled data available from a series of 
registers which can be queried by a MODBUS client.  Statistical data are also computed and made available by 
the iPackACCESS through an additional set of MODBUS registers. 
 
The iPackACCESS has configurable averaging intervals and also allows streaming of 1-second data.  The 
iPackACCESS is programmed using the SDR software. 
 

 SymphoniePLUS3 

Each of the 15 channels’ averages, standard deviations, and other statistical values are calculated from 
continuous 1 second data samples.  Scaled values are calculated based on the scale factors and offsets 
programmed into the logger.  Data intervals are calculated every 10 minutes, time stamped with the beginning 
time of each interval and written to the SD Card (SD) at the top of each hour.  
 
Symphonie Data Retriever (SDR) software is then used to process raw data files stored on your computer 
either from an SD Reader or email.  Configuration of iPacks is also performed by the SDR software with the 
use of a programming cable.  
 
Sensor scale factors and offsets programmed into the SymphoniePLUS3 logger can be edited later with SDR if 
there is a mistake or if a sensor is added or changed.  Corrections can also be made remotely using a sensor 
patch file.  Once a sensor’s scale factor or offset has been corrected, 10 minute data can be reprocessed.  The 
parameters in SDR’s Site Information Editor are used to create the tab-delimited text file (ASCII), so there is 
always an opportunity to make changes to how the raw files will be processed before generating ASCII data 
files for export.   
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Changes to the logger’s programming can be made immediately available to the MODBUS client by disabling 
and then re-enabling on the MODBUS status page.  For example, if a sensor’s scale factor is incorrect and is 
changed, disabling and re-enabling will show the effect of the change on the scaled real-time data. 
 

MODBUS Data Flow Diagram 

 
1. Sensor signals are received by the logger through its wiring panel.  

2. At the same time, the raw data is passed on to the iPackACCESS, where it is used for statistical 

calculations and formatted into Modbus registers (shown in the chapter MODBUS 

Communication). 

3. When the Modbus server is enabled, the iPackACCESS takes the conversion factors from the 

logger and stores them in the iPackACCESS. As raw data is collected, the iPackACCESS scales 

the data using the conversion factor and makes the scaled statistical and real time data 

available on their designated registers.  

4. The iPackACCESS collects the raw 1 second data and performs statistical calculations on a 

configurable interval 

5. All of the data (raw real time, scaled real time, scaled statistical and raw statistical) is processed 

in the iPackACCESS and made available on each corresponding register, where it can be polled 

through an Ethernet network by a Modbus client.  

6. A Modbus client can poll the iPackACCESS registers for data once a second.  
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Examples of Network Configurations 

 

Direct connection with static IP addresses 

 
 
 
 
 
 
 

 
 
 
This example shows the most basic network setup with an iPack directly connected to a computer running a 
MODBUS client. DHCP is disabled, and a fixed IP address (programmed in the iPack) is used to connect to the 
MODBUS client. No email is enabled, and no DNS is enabled.  
 

Network Configuration 

Parameter iPackACCESS  Computer 

Enable DHCP: No No 

Static IP Address 192.168.1.100 192.168.1.40 

Subnet Mask 255.255.255.0 255.255.255.0 

Gateway Not used Not used 

DNS1 Not used Not used 

DNS2 Not used Not used 

 

      MODBUS Client Computer 
Settings: 
Enable DHCP:  No 
Static IP Address: 192.168.1.40 
Subnet Mask:  255.255.255.0 
Gateway:  Not Used 
DNS1:    Not Used 
DNS2:   Not Used 

LA
N 

IP:  192.168.1.100 

Number of Clients:  1 

 

[0] Disable Modbus  + 
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Router with DHCP 

  

 
This example shows a common network setup with a DHCP server assigning IP addresses to all devices. DHCP 
is enabled and responsible for giving the iPackACCESS and computer their IP addresses. In the iPackACCESS 
settings, DHCP is turned “ON” and Static IP address is not used.  No email is enabled, and no DNS is enabled; 
data are available over the local network.  
 

Network Configuration 

Parameter iPackACCESS  Computer 

Enable DHCP: Yes Yes 

Static IP Address Assigned by DHCP Assigned by DHCP 

Subnet Mask Assigned by DHCP Assigned by DHCP 

Gateway Not used Not used 

DNS1 Not used Not used 

DNS2 Not used Not used 
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Router with DHCP and Internet email 

 
 
 
 

This example shows a network with email enabled and the DHCP server assigning an IP address only to the 
computer, not the iPackACCESS.  The iPackACCESS has DHCP off, which means it has a fixed IP address. The 
iPackACCESS must have the same Subnet as the computer and router.  The computer has DHCP enabled, so 
the router provides the computer with an IP address. This example has both the DNS servers enabled (see 
“ISP Access“ tab in SDR software showing the iPackACCESS’s *.ipk file; see example below) and the SMTP 
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server information (see the “Mail Access “ tab in SDR software showing the iPackACCESS’s *.ipk file; see 
example below). 

       
 

Network Configuration 

Parameter iPackACCESS  Computer 

Enable DHCP: No Yes 

Static IP Address 192.168.3.100 Assigned by DHCP 

Subnet Mask 255.255.255.0 Assigned by DHCP 

Gateway 192.168.3.1 Not used 

DNS1 203.64.21.245 Not used 

DNS2 203.64.22.123 Not used 
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Networking Considerations 

 
 MODBUS default port is 502 but the iPackACCESS can be configured to use any port number. 
 The iPackACCESS supports DHCP for automatic configuration of network address. 
 If DHCP is disabled, you will need to manually edit the Static IP Address, Subnet Mask, and Gateway IP 

Address.  Your IT administrator may be able to assist you with this. 
 As a security feature, the iPackACCESS can be configured to limit the allowed connections. 
 The iPackACCESS implements a standard 10baseT Ethernet interface that can auto-negotiate full or half 

duplex and adjust for crossover. 
 The iPackACCESS allows up to 4 simultaneous client connections. 
 The iPackACCESS allows configuration of SMTP and POP ports to accommodate different firewall settings. 
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iPackACCESS Components (Quick Tour) 

Unpacking the iPackACCESS 

 
Follow standard precautions for handling electronic components when unpacking the iPackACCESS.  Discharge 
static electricity from your body by touching a piece of grounded metal or wearing a ground strap.  
 

Confirm that you have received all components by comparing your order to the packing list shown below.  
Immediately contact Renewable NRG Systems if any of the components are missing. You should find the 
following standard equipment: 

  Qty. (1) iPackACCESS (Picture 2) 

  Qty. (1) GPS Antenna Cable 
  Qty. (4) #10-32x4",Machine,HexHead,18-8SS screws 
  Qty. (1) Ethernet cable boot assembly (also shown in Picture 3) 
 

  

       Picture 1 
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Picture 2 
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iPackACCESS Connections & Components 

Ethernet boot assembly 

Remove Ethernet boot assembly components from bag and feed the cable through components in the 
sequence shown in Picture 4.  Crimp the RJ-45 Ethernet Connector to the end of the cable.  

 

 

Picture 3 

 

Picture 4 

Insert RJ-45 into the slot labeled “Ethernet” on the iPackAccess and tighten all Ethernet cable boot assembly 
components making sure that the arrow on the plastic piece is facing up and pointing toward the connection 
as shown in Picture 5.   Make sure all components are tight and the connection is secure enough to provide a 
water proof seal by gently pulling on the Ethernet cable.  Pulling on the cable should not cause it to move in 
the socket.       
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Picture 5 

 

 

 
 
 

Arrow 
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iPackACCESS Configuration 

The iPackACCESS is pre-configured to utilize DHCP.  If your network supports DHCP, no configuration of 
network address is required.  Default parameters are provided in the iPackACCESS; however, other settings 
can be programmed using the SDR software as described below. 
 
iPackACCESS programming is done using the Symphonie Data Retriever software (version 7.03.15 or higher).  
Symphonie Data Retriever (SDR) can be downloaded from here:   
 
http://www.renewablenrgsystems.com/TechSupport/SoftwareDownloads.aspx 
 
Uploading from SDR requires connection directly to the iPackACCESS or through the logger’s iPack 
programming port (recommended).  The Logger Direct Editor screen can be used to program the logger and is 
accessed through SDR’s Modify iPack Settings screen.  Scale factors and offsets programmed into the logger 
will be used to calculate real-time scaled data, so be sure to take extra care in programming these values.  
 
Details of SymphoniePLUS3 programming can be found in the SymphoniePLUS3 User’s Manual, which can be 
found on our website here: 
 
http://www.renewablenrgsystems.com/TechSupport/Documentation.aspx 
 
The iPackACCESS can be configured for MODBUS communication only, or it can be configured for both 
MODBUS communication and transmission of wind resource assessment data.  Instructions for configuring the 
iPackACCESS for transmission of wind resource assessment data can be found in the chapter called Wind 
Resource Assessment (WRA) Data Stream. 

Grounding 

Whenever coming in contact with the iPackACCESS or SymphoniePLUS3 logger, either in the field or indoors, it 
is good practice to first grasp a piece of grounded (earthed) metal before touching the logger to avoid a 
potentially damaging electrostatic discharge (ESD) to the equipment. 

Establishing Serial Connection with the Computer  

Connect the iPackACCESS to the SymphoniePLUS3, and then use the programming adapter and cable to 
connect to the PC.  Connect the computer end first, and then connect to the programming adapter.  If your 
computer doesn’t have a 9-pin serial port, you will need to use a USB to serial converter with the iPack 
programming cable.   

Starting Symphonie Data Retriever iPack Configuration Software 

Start the Symphonie Data Retriever Software from the Windows Start menu.  The program is usually found 
here:  C:\NRG\SymDR\SDR.exe. 

http://www.renewablenrgsystems.com/TechSupport/SoftwareDownloads.aspx
http://www.renewablenrgsystems.com/TechSupport/Documentation.aspx
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Establishing serial communication with SDR software 

From the main SDR Window, select Site>Modify iPack Settings.  Check the lower left hand corner of the 
Modify iPack Settings window for a message.   
 
If you receive no message or “iPack Communication Failed,” it is likely that the COMM port on your computer 
is not configured properly.  You must disable any programs that might be trying to access the COMM port. 
 
Select Options>Comm Port from the menu, and select the communication port you will be using to connect 
to the iPack.  
 

 
 

The COMM port setting will be restored the next time you use the program and only needs to be entered the 
first time you use the program or following a reinstallation of SDR software.   
 
Note:  If none of the COMM ports in the Select Comm Port window can be selected, you will need to use 
Windows Control Panel’s Device Manager to change the available COMM port number to 1 through 16.   
 
If the port is properly configured, you should see the message “Verifying iPack Connection” and then “iPack 
detected” at the bottom of the window.   
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Choose the MODBUS tab and select General to begin configuring the iPackACCESS. 
 

 
 
 

MODBUS Configuration Parameters 

Parameter Name Parameter Description 

Enable MODBUS? This is a Boolean switch to enable or disable the persistent 
configuration of the iPack for use as a MODBUS server. 

MODBUS Slave 
Address 

The address used to identifier the iPack on the MODBUS Network. This 
number can be 1-255. 

MODBUS Port ( 1 – 
65535) 

Port Number used for MODBUS TCP/IP communication. Default is the 
reserved port 502. 

Enable DHCP? A Boolean switch to turn on or off the use of DCHP to acquire network 
parameters.  The Static IP Address, Subnet Mask, and Gateway IP 
Address fields are not used with DHCP enabled. 

Static IP Address Static IP address that can be assigned to the iPackACCESS 

Subnet Mask Subnet Mask for the network to which the iPack is connected. 

Gateway IP Address IP address of Gateway the iPack may connect through. 

Statistical Data 
Interval 

Length of time data are acquired for statistical calculations (1, 2, 5, 10, 
15, 30, and 60 minutes). 

Stale Data Timeout 
(sec) 

The amount of time in seconds elapsed since a real time data set was 
acquired that designates the data set as stale. 
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Next, select the Security tab and enter IP Addresses. 
 

  
 

MODBUS Configuration Parameters 

Parameter Name Parameter Description 

Use Secure IP 
Addresses 

This is a switch that when not set the iPackACCESS will respond to 
requests from any IP address. If it is set, it will only respond to the IP 
addresses specifically stated. 

Allowed IP Addresses Ten allowed IP address fields . The iPackACCESS will only respond to 
these addresses if the “Secure IP Addresses” configuration is set.  

 

Connect to Network 

 
Connect and secure the cable assembly to the iPackACCESS’s Ethernet port, and connect the other end to your 
network or to a computer running the MODBUS Client Demonstration Application. 

Verifying Network Connection 

The connection status page [Home][3][4][2] should display the type of connection (Half, Half-x, Full, or 
Full-x) in the lower right corner.  This verifies that the iPackACCESS has detected the network connection.  A 
“No Link” message indicates that no network connection is detected. 
 
The MODBUS status page [Home][3][4][6] should show the expected IP Address of the iPackACCESS based 
on the chosen network configuration. 
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To verify network communication, open a DOS window on a computer connected to the same network as the 
iPackACCESS.  At the command prompt, type “ping” followed by the iPackACCESS’s IP Address, and hit Enter. 
The display should show successful communication with no packet loss. 
 
Once successful connection and communication have been verified, start your MODBUS client and make sure 
that it communicates successfully. 
 

MODBUS Client Demonstration Application 

The MODBUS Client Demonstration Application communicates with the iPackACCESS via ModbusTCP and can 
be used to view the Modbus Register Set of the iPackACCESS.  The purpose of this demo application is to 
provide a simple way to verify network connectivity and test data streams from each attached sensor.   
 
The MODBUS Client Demonstration Application can be downloaded from here: 
 
http://www.renewablenrgsystems.com/TechSupport/SoftwareDownloads.aspx 
 
Extract ZIP file and instructions to any local folder (for example, C:\temp).  This application has been tested on 
Windows XP and Windows 7 and can be run directly from the executable file (no installation required). It can 
be run directly from a USB drive, or from a network file server.  This makes it easy to test from any location on 
the network without the need for Administrator rights and program installations. 
 

 
 
 

http://www.renewablenrgsystems.com/TechSupport/SoftwareDownloads.aspx
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Using the MODBUS Client Demonstration Application 
 

 Start the application by double-clicking the ModbusDemo.exe file 

 Enter the active IP Address of the iPackACCESS (the iPackACCESS’s IP address can be found by pressing 
HOME, [3], [4], [6] on the logger’s keypad) 

 Click the Enable checkbox 

 Select either Real-time or Statistics data streams using the radio buttons 

 The list will show both raw and scaled data streams 

 Timing and error information is reported at the bottom of the window 

 
Tips 

 The MODBUS Client Demonstration Application attempts to open a TCP socket connection to the iPackACCESS 
on port 502.  Warning messages may appear from your firewall the first time this application attempts to connect.  
If this occurs, select the option to allow the use of port 502 by the demo application. 

 
 Since the iPackACCESS can support multiple MODBUS Clients, this application can be used simultaneously with 

other MODBUS Clients.  This can be helpful in debugging the setup of MODBUS tag information in the end user 
application. 

 

Checking iPack status 

 
[Home][3][4] = iPack 

    
1. eMail Now 

2. Connection Status 

3. GPS Status 

4. iPack Event Log 

5. Manual Dial (not used with iPackACCESS) 

6. Modbus Status  * 

If an iPackACCESS  is attached to the SymphoniePLUS3, the status screen will display the above menu. 
 
 The + symbol will alternate with the * symbol to indicate the iPackACCESS is on.  [Home][3][4][2] will 
show the iPackACCESS’s live Connection Status page, which displays the model of iPackACCESS in use, the 
revision level, the battery voltage, and the connection type. 

 

iPackACCESS v02 Eth 

Network Connected 

 

Batt: 12.8    Full + 

 
Connection type can be: 

Half – half duplex connection 

Half-x – half duplex connection with crossover  

No Link – iPackACCESS has not detected a network 

Full –full duplex 

Full-x – full duplex connection with crossover 

 
[Home][3][4][3] will show the iPackACCESS’s GPS Status page. The GPS Status page displays the model of 
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iPackACCESS in use, the revision level, latitude and longitude, altitude, and number of acquired GPS satellites. 
 

iPackACCESS v02 Eth 

Lat:   

Lon: 

Alt:  Sat: 4 *  

 
[Home][3][4][4] will show the iPackACCESS’s Event Log.  The iPack Event Log allows the user to scroll 
through numbered events by pressing the up and down arrow keys. The most recent events are displayed 
first. Using the numeric keypad, the user can enter a number jump to a particular event. 
 
[Home][3][4][5], “Manual Dial” is currently not used by the iPackACCESS. 
 
[Home][3][4][6] will show the iPackACCESS’s MODBUS Status page.  The IP Address of the iPackACCESS is 
displayed at the top of the screen along with number of connected clients.  Additional network information can 
be displayed by pressing the following keys: 
 

1 Active IP Address (iPackACCESS) 

2 DNS1 

3 DNS2 

4 MAC Address  

 Press 0 to enable or disable MODBUS communication. 
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MODBUS Communication 

MODBUS Application Protocol Specification V1.1b is followed when implementing the communications  portion 
of the protocol. Only the standard exception codes in the table below are supported.  
 

MODBUS Exception Codes 

Code Name Meaning 

01 ILLEGAL FUNCTION The function code is not supported by the iPackACCESS or is 
not in the correct state to be able to perform the function. 

02 ILLEGAL DATA 
ADDRESS 

An address in the requested data range is not an allowable 
address. 

03 ILLEGAL DATA 
VALUE 

The value in the data field is not allowable by the 
iPackACCESS. 

04 SLAVE DEVICE 
FAILURE 

An unrecoverable error occurred when the iPackACCESS was 
performing the request. 

Input Register Data and Addressing 

The iPackACCESS only supports the “Input Register” primary table. Therefore only MODBUS function 4 will be 
supported.  This function is read only.  The client will request that the input register table be read by sending 
function 4, the start address, and the number of registers that it would like to read. 
 
The information for this section is described in the text below and summarized in the tables and figures. 

 A time stamp is provided for each block of data. The real time data time stamp is the latest time 
stamp sent from the logger. The statistical data time stamp is the time at the beginning of the last 
calculated interval. Each time stamp has the Year, Month, Day, Hour, Minute, and Seconds stored 
in a different register in this sequence. 

 For the real time data block, the values for each channel are represented by an unsigned 16 bit 
number.  The 15 registers after the time stamp contain all the real time data for each of the 
channels. 

 For the statistical data, the values for each channel are represented by four bytes of data in single 
precision floating point format following IEEE 754 except for the count.  Each statistical value is 
contained in two MODBUS registers as each register is two bytes, except the count which is 
represented by a single unsigned 16 bit integer in one register.  The first register containing the 
statistical data is the most significant half of the word, and the second contains the least significant.  
The order for each piece of statistical data for each channel is:  Average, Standard Deviation, 
Maximum, Minimum, and Count.  Channel one’s start register starts after the last time stamp 
register. 

 A header is located at the address space before the time stamp for each block of data.  This header 
is considered an optional block of information.  If additional information is added to the header, it 
will expand to lower addresses.  Each header has an error register below the time stamp address. 
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 The error register indicates problems with the iPackACCESS and communication. The 
communication errors may be redundant to the built-in error information in the MODBUS 
communication protocol.  

 The real time data contain an additional register that will indicate whether the real time data are 
stale. The data are considered stale if there has not been an update within a certain configurable 
time period. This register reports a 0 if the data are not stale and a 1 for stale data. 

MODBUS Registers 

 
 

MODBUS Register 
Address 

Register Content 

1995 Real Time Count 

1996 Board Temp 

1997 Battery Voltage 

1998 Stale Data 

1999 Error Code 

2000 Year 

2001 Month 

2002 Day 

2003 Hour 

2004 Minute 

2005 Second 

2006 Channel 1 Data 

2007 Channel 2 Data 

2008 Channel 3 Data 

2009 Channel4 Data 

2010 Channel 5 Data 

2011 Channel 6 Data 

2012 Channel 7 Data 

2013 Channel 8 Data 

2014 Channel 9 Data 

2015 Channel 10 Data 

2016 Channel 11 Data 

2017 Channel 12 Data. 

2018 Channel 13 Data 

2019 Channel 14 Data 

2020 Channel 15 Data 

Raw Real Time Data MODBUS Addresses 

 

Modbus Register 
Address 

Register Content 

2995 Real Time Count 

2996 Board Temp 

2997 Battery Voltage 

2998 Stale Data 



  MODBUS Communication 

 
 

iPackACCESS_Manual     |     Rev 4     |     1 May 2015     |     support@renewableNRGsystems.com     ||     32 

 

2999 Error Code 

3000 Year 

3001 Month 

3002 Day 

3003 Hour 

3004 Minute 

3005 Second 

3006 Scaled Channel 1 Data Most Significant Word 

3007 Scaled Channel 1 Data Least Significant Word 

…. …. 

3034 Scaled Channel 15 Data Most Significant Word 

3035 Scaled Channel 15 Data Least Significant Word 

Scaled Real Time Modbus Register Addresses 

 
 
 

MODBUS Register 
Address 

Register Content 

3998 Error Code 

3999 Count 

4000 Year 

4001 Month 

4002 Day 

4003 Hour 

4004 Minute 

4005 Second 

4006 Channel 1 Average Most Significant Word 

4007 Channel 1 Average Least Significant Word 

4008 Channel 1 SD Most Significant Word 

4009 Channel 1 SD Least Significant Word 

4010 Channel 1 Max Most Significant Word 

4011 Channel 1 Max Least Significant Word 

4012 Channel 1 Min Most Significant Word 

4013 Channel 1 Min Least Significant Word 

…. …. 

4118 Channel 15 Average Most Significant Word 

4119 Channel 15 Average Least Significant Word 

4120 Channel 15 SD Most Significant Word 

4121 Channel 15 SD Least Significant Word 

4122 Channel 15 Max Most Significant Word 

4123 Channel 15 Max Least Significant Word 

4124 Channel 15 Min Most Significant Word 

4125 Channel 15 Min Least Significant Word 

Raw Statistical Data MODBUS Addressing 
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Modbus Register 
Address 

Register Content 

4998 Error Code 

4999 Count 

5000 Year 

5001 Month 

5002 Day 

5003 Hour 

5004 Minute 

5005 Second 

5006 Scaled Channel 1 Average Most Significant Word 

5007 Scaled Channel 1 Average Least Significant Word 

5008 Scaled Channel 1 SD Most Significant Word 

5009 Scaled Channel 1 SD Least Significant Word 

5010 Scaled Channel 1 Max Most Significant Word 

5011 Scaled Channel 1 Max Least Significant Word 

5012 Scaled Channel 1 Min Most Significant Word 

5013 Scaled Channel 1 Min Least Significant Word 

…. …. 

5118 Scaled Channel 15 Average Most Significant Word 

5119 Scaled Channel 15 Average Least Significant Word 

5120 Scaled Channel 15 SD Most Significant Word 

5121 Scaled Channel 15 SD Least Significant Word 

5122 Scaled Channel 15 Max Most Significant Word 

5123 Scaled Channel 15 Max Least Significant Word 

5124 Scaled Channel 15 Min Most Significant Word 

5125 Scaled Channel 15 Min Least Significant Word 

Scaled Statistical Modbus Register Addresses 
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Wind Resource Assessment (WRA) Data Stream 

If you want the iPackACCESS to email *.RWD files of time-stamped 10 minute averaged data, you will need to 
program Mail Access and Email Info parameters into the iPackACCESS.  The programming has been organized 
into a familiar folder-tab system.  The programming will be discussed tab by tab. 
 
You will want to take extra care during this section.  Even a minor typographical error will prevent the 
iPackACCESS from connecting to the Internet.  It is strongly recommended that you get the iPackACCESS 
working before bringing it to the field for installation! 

Viewing the Pre-Loaded iPack Settings  

From SDR’s Modify iPack Settings window, select File>Load from iPack from the menu.  The status line on 
the bottom of the screen should show the message “Transferring >>>>>>” followed by the message “Done!”  
You will now see the fields populated with information that is currently programmed into your iPack. 
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All the checkboxes will be checked, and you may now edit each setting (if not, go to Options>Check All).  
General information regarding each setting is provided below.   

ISP Access Tab 

The only parameters on the ISP Access tab utilized by the iPackACCESS for MODBUS communication are the 
Primary and Secondary DNS fields. 

Mail Access Tab 

All the checkboxes should still be checked, and you may edit each Mail Access setting.  General information 
regarding each setting is provided below.  Note that the SMTP server setting is used to send the email from 
the iPackACCESS and should not be confused with the POP3 server, which is used to access patch files 
addressed to the logger and patch files and firmware updates addressed to the iPackACCESS.   
 
 

 

SMTP Server Name 

This is the SMTP server name that your ISP will provide and/or you can find on your ISP’s web site.  It is used 
to send mail from the iPackACCESS.   
 

 Enter it exactly as your ISP provided; do not enter any extra spaces or quotation marks; check that there 
are no leading or trailing spaces in your entry.   
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My SMTP Server requires authentication 

Some SMTP servers require a login and password before allowing you to send mail.  If the SMTP server does 
not require authentication, select “No.”  If your ISP requires SMTP server authentication, select “Yes” and 
enter the SMTP login and password.   

POP3 Server Name 

This is the name of the POP3 server that your ISP will provide and/or you can find on your ISP’s web site.   
 

 Enter it exactly as your ISP provided, and do not enter any extra spaces or quotation marks; check that 
there are no leading or trailing spaces in your entry.   

Mailbox Name 

This is the mailbox account name your ISP provided or you selected when you set up your email account for 
the iPackACCESS.  
 

 This is the mailbox account name on the POP3 server that the logger points to in order to retrieve mail 
(patch files, for example). 

 Enter it exactly as your ISP provided; do not enter any extra spaces or quotation marks; check that there 
are no leading or trailing spaces in your entry.   

 It should be something like: 
 Logger 
 7345552555 

Mailbox Password 

This is the mailbox password your ISP provided or you selected that allows access to your mailbox.   
 

 Enter it exactly as it is provided to you.   
 When you enter your password, it will be displayed as asterisks (*) so it will be secure if someone else 

reads the information from the iPackACCESS.   
 When you read the parameters from the iPackACCESS and then save them to the iPackACCESS, all 

parameters, including the mailbox password, are returned unchanged unless the user changes them and 
then chooses File>Save to iPack.   

 
Internet Time Server Name  

 As part of the iPackACCESS’s connection routine, it gets the current time (in UTC) from the Internet and 
updates the SymphoniePLUS3’s clock.  

 The user must enter a local time server for the iPackACESS to use.   

 Enter the time server name exactly as provided, and do not enter any extra spaces or quotation marks; 
check that there are no leading or trailing spaces in your entry; be sure to include the decimal points in 
the name.  

 
Once the information on this tab has been edited and double checked, move to the E-Mail Info tab. 

 Email Info Tab 

All the checkboxes should still be checked, and you may edit each Email Info setting.  General information 
regarding each setting is provided below.   
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Recipient’s E-Mail Address 

This is the primary e-mail address where the SymphoniePLUS3’s iPack is going to send the data.   
 

 This can be your e-mail at work.  
 Enter it exactly as your ISP provided; do not enter any extra spaces or quotation marks; check that there 

are no leading or trailing spaces in your entry.   
 It should look something like: 
 jsmith@mycompany.com 

Recipient’s Name 

This field is the text portion of the e-mail address.   
 

 If you look at an e-mail in your in-box, it will have the “To” item as something like, “John Smith” 
<jsmith@mycompany.com>.   

 This entry is the “John Smith” portion of the recipient’s e-mail address.   
 This field is optional but is useful if someone has to sort through incoming emails.   
 It could look something like: 
 John Smith 

CC E-Mail Address 

This is an additional e-mail address where the iPackACCESS is going to send the data.   
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CC E-Mail Address 2 

This is also an additional e-mail address where the iPackACCESS is going to send the data.   

Sender’s E-Mail Address 

This is the e-mail address that will appear in the “from” of the emails being sent to the recipient’s email 
address from the iPackACCESS.  It is often identical to the Mailbox Name plus the “@myisp.com” part of the 
email address.  However, the Sender’s E-Mail Address is NOT necessarily the address to which patch files 
should be sent. 
 

 Do not enter any extra spaces or quotation marks; check that there are no leading or trailing spaces in 
your entry.   

 It should look something like: 
 logger@mycompany.com 

E-Mail Subject Line 

This entry will become the subject line of the e-mail that you receive from the iPackACCESS and may contain 
letters, numbers and other symbols.   
 

 It is typically a description of the site from which the iPackACCESS that will be calling.   

 It should look something like: 
 Site 1234 – Derry Mountain 

Patch Password 

The patch password is a security measure that protects your data logger from unwanted or accidental 
patching. 
 

 Enter a patch password – do not leave blank. 
Once the information on this tab has been edited and double checked, move to the Call Schedule tab. 

Setting iPackACCESS Preferences  – iPackGPS/Acc Tab  

This screen provides access to new features of the iPackACCESS unavailable in previous iPack versions.    
 

Settings 

Like all other screens in the Modify iPack Settings window, once you have made a change, you must go to File 
and choose Save to iPack. 

mailto:logger@mycompany.com
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 The “Download partial files” setting allows the user to toggle on and off downloading of partial files. 
 A “partial file” refers to a file that includes less than 24 hours of data, typically from midnight up until 

the iPack’s scheduled call time. 
 Disabling the downloading of partial files and checking of POP3 can reduce air time.  However, this is 

generally not recommended for remote sites. 
 If POP3 checking is disabled, the iPack will not be able to receive patches or firmware updates until the 

setting is changed via a direct connection to SDR.    

Actions 

The Actions screen provides voltage readings that can be useful for diagnosing a problem and a button for 
updating the iPackACCESS’s firmware. 
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  iPack battery voltage and voltages from various locations on the iPackACCESS’s circuit board are 

displayed here when the Get Voltages button is clicked. 

 iPackACCESS firmware version can be updated via SDR and the iPack programming cable using the 
Firmware Upload button.  

 A link to the site used for remote firmware updates is also displayed on this screen. 
 The iPackACCESS event log will show “UPDATE_DOWNLOAD_EVT” and “UPDATE_APPLY_EVT” to help 

track the installation of the new firmware. Note that these events will only appear for remote updates, 
not for updates performed using SDR’s “Firmware upload” button. 

 Firmware updates via SDR and the iPack programming cable are completed in a few minutes. 
 

Saving the iPack Displayed Setup to the connected iPack 

After editing the parameters on the screen, save the changed parameters to the iPack by selecting File>Save 
to iPack.  This will download all of the checked settings to the attached iPack.  On the lower left of the Modify 
iPack Settings window you should see the message “Transferring>>>>>>” and then “Done!”  You’ve now 
completed programming the iPackACCESS for emailing *.RWD files. 
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Saving a copy of the iPack File (.ipk) to your computer   

Save a copy of the iPack settings by selecting File>Load from iPack.  This will load the current iPackACCESS 
configuration to your computer screen.  Then choose File>Save iPack File.   This will save a copy of the 
iPackACCESS’s configuration file (*.ipk file) to your computer.  Remember to send a copy of the *.ipk file to 
your site management team – it is important to keep the *.ipk file safe! 

 

Opening a Saved iPack File (.ipk) 

 
From the Modify iPack Settings Window, select File>Open iPack File.  In the future, you may want to open 
a saved iPack file, edit the settings and then send it back to the iPackACCESS.  You can also do this to check 
the saved iPack file. 
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Technical Specifications  

 
Accessory Type  Real-time, statistical, and wind resource assessment data transfer communications device for SymphoniePLUS3 data loggers  

Applications  • Real-time and statistical data accessible to wind farm SCADA system via MODBUS TCP  
 
• Wind resource assessment data is available by email if internet is accessible via wind farm network  
 

Instrument compatibility  SymphoniePLUS3 data logger  

Function  MODBUS TCP server available over RJ45 Ethernet connection  

INSTALLATION  

Mounting  iPackACCESS stacks with SymphoniePLUS3 data logger on long logger mounting screws  

DATA COLLECTION  

Software  Configured with Symphonie Data Retriever (SDR)  

Data Delivery  • Real-time, 1-second values of all 15 channels available from MODBUS TCP server  
 
• Mean, standard deviation, minimum, and maximum values at user-selected time interval (1, 2, 5, 10, 15, 30, and 60 minutes) available 
from MODBUS TCP server  
 
• SymphoniePLUS3 10-minute data is available by email if internet is accessible via wire-connected SCADA network1  

 

CONFIGURATION  

User Interface  • Status reporting on data logger front panel  
 
• Configuration via SDR on Windows PC  
 

Configurable Parameters  • MODBUS secure client list to prevent unauthorized access by limiting the acceptable IP addresses for incoming connections (up to 10 
allowable addresses)  
 

POWER REQUIREMENTS  

Batteries  Lead acid gel cell recharged via external power input  

External power input  14-28 VDC  

PHYSICAL  

Connections (Physical)  • RJ45 connector for connection to SCADA system  
 
• SymphoniePLUS3 to iPackACCESS via DB25 interface  
 
• Two (2) screw terminals for solar PV panel or external power supply input  
 
• Two (2) screw terminals for external battery  
 
• One (1) screw terminal for earth ground, pre-wired for connection to data logger earth ground stud  
 
• GPS antenna connector QMA female  
 

Weight  To Be Determined  

Dimensions  165 x 222 x 102 mm (6.5 x 8.75 x 4.0 inches)  

MATERIALS  

Enclosure  Polycarbonate plastic  

ENVIRONMENTAL  

Operating Temperature 
Range  

-40 °C to 65 °C (-40 °F to 149 °F)  

SYSTEM REQUIREMENTS  

Computer  Windows PC with Symphonie Data Retriever (SDR) required for programming of iPackSCADA settings  

Operating System  Symphonie Data Retriever (SDR) requires Windows 95 or higher  

Related Hardware  • SymphoniePLUS3 Data Logger (Item 5504)  
 
• iPack Programming Kit (Item 3368)  
 
• Universal iPack Charger (Item 3615)  
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Warranty Statement 

 
Renewable NRG Systems (RNRG) warrants its products for a period of two years from date of original 
purchase solely for the benefit of the original consumer purchaser. If this product is determined to be 
defective in materials or workmanship, RNRG will, at RNRG’s option, repair or replace this product without 
charge. This warranty does not cover damage due to improper installation or use, accident or misuse, 
damages due to any unauthorized service or lightning. This warranty also will not apply if any seal on any 
instrument or sensor is broken, if any cable has been severed, or the equipment was not adequately 
grounded. 
 
To return a defective product, request an RMA (return merchandise authorization) number by calling us at the 
number below or by emailing support@renewablenrgsystems.com, or by submitting a request through our 
website’s Technical Support area. 
 
Please provide the serial number of the item as well as date of purchase. No products will be accepted for 
warranty work without an RMA number. The product must be returned, postage prepaid, to RNRG with a brief 
description of the problem, RMA number and a return address with phone number. 
The foregoing limited warranty is given in lieu of all other warranties, express or implied. RNRG specifically 
disclaims all implied warranties including, but not limited to, any implied warranties of merchantability and 
fitness for a particular purpose. 
 
The above limited warranty expressly excludes, and RNRG shall not be liable for, any incidental or 
consequential damages caused by or related to the selection, use of, inability to use or malfunction of this 
product. 
 
RNRG will make a good faith effort to repair or replace promptly any product which proves to be defective 
within the warranty period. First, contact RNRG or the representative from whom the product was purchased 
and ask for an RMA number. Inspect your shipments for damage to packages or missing packages 
immediately upon receipt. Record any such exceptions on the freight receipt of the delivery agent. If any 
contents are damaged or missing, report this in writing to the freight carrier and send RNRG a copy of the 
damage report. If you insured the shipment yourself, report any damages to your insurance carrier. 
 
Tel: 802-482-2255 
Fax: 802-482-2272 
email: support@renewablenrgsystems.com 
website: https://www.renewablenrgsystems.com/technical-support 

  

mailto:support@renewablenrgsystems.com
https://www.renewablenrgsystems.com/technical-support
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Sending Items for Repair 

INTERNATIONAL CUSTOMERS  

1. Contact Renewable NRG Systems by phone, email, or through our website to obtain an RMA 

number (Return Material Authorization). Write the RMA number clearly on all shipping cartons.  

 
Tel: 802-482-2255  Fax: 802-482-2272 
 
email: support@renewablenrgsystems.com 
 
website: https://www.renewablenrgsystems.com/technical-support 
 
2. Send your item to Renewable NRG Systems "Delivery Duty Paid" (see address below) using a 

door-to-door courier service such as UPS, FedEx, or DHL. If the repair is not urgent, please send your 

package by Airmail. (Courier services deliver the package directly to us, customs cleared.)  

Renewable NRG Systems will not accept packages shipped Freight Collect or with Collect 
charges.  
 
If Renewable NRG Systems refuses the shipment, the courier service will charge your account return freight 
charges.  
 
DO NOT send return items by direct or consolidated air freight service with an airline.  
The cost for air freight may seem lower than the courier service, but air freight costs do not include customs 
clearance, airport handling, break bulk fees, and inland delivery to Renewable NRG Systems.  
 
3. Attach a Commercial Invoice to the carton. The Commercial Invoice should include the following 
information:  

 Name and address of the shipper.  

 Renewable NRG Systems' complete address and telephone number as the consignee.  
 Description of the items being returned.  

 Quantity of each item being returned.  
 Value for customs / insurance (purchase price or replacement cost).  
 Number of cartons with respective weights and dimensions.  
 Please include the following statement to avoid paying US import duties:  

 
"These items are being returned to their U.S. manufacturer. Country of manufacture and origin is USA, HTS 
CODE 9801.00.1012."  
 
4. Pack your repair item in a sturdy packing carton. Tag each item with a brief description of the 
problem.  
 
5. Insure your shipment against damage or loss in transit. Be sure to check the appropriate box and enter 
a "Value for Carriage" (insurance) on your air waybill. The value is the purchase price of the equipment or 
what it would cost to replace the equipment if the shipment were lost. Keep a record of the tracking number.  
 

mailto:support@renewablenrgsystems.com
https://www.renewablenrgsystems.com/technical-support
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Once your item arrives, we will assess the item and notify you of the repair cost. Any repair charges and 
freight costs, if applicable, are payable before Renewable NRG Systems will return the repaired item to you via 
door-to-door courier service. Renewable NRG Systems will send you a shipment advisement when the repaired 
item is shipped. 

International Customers:  

Before sending the repair item to Renewable NRG Systems, check with your local customs authorities about 
provisions in your country for exporting and re-importing repair items. Some countries treat repair shipments 
like new shipments and charge import duties and taxes again upon re-importation. Other countries have 
specific steps to follow or specific forms to complete which help reduce the import duties upon re-import of the 
item.  

US CUSTOMERS  

Please see items 1, 4, and 5 above. Send your item(s) to Renewable NRG Systems “Freight Prepaid and 
Insured.” Shipments sent freight collect will not be accepted by Renewable NRG Systems.  
 

 
 
 
 
 
 
 
 

Renewable NRG Systems  
Attn: RMA- __________  
110 Riggs Road  
Hinesburg VT 05461 USA 
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References 

 
Some of our products incorporate software that is available in the open source community, including 
www.freertos.org (version 6.00) and www.savannah.nongnu.org.  The information that follows is provided to 
comply with the terms of use.  
 
www.freertos.org 
FreeRTOS is a real time operating system available in the open source community and utilized in the 
iPackACCESS.  Source code is available from NRG upon request.  
 
www.savannah.nongnu.org 
We are using the lwIP lightweight TCP/IP stack in the iPackACCESS. 
 
 (Copyright (c) 2001-2004 Swedish Institute of Computer Science. All rights reserved.)  
 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:  

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer.  
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.  
3. The name of the author may not be used to endorse or promote products derived from this software without 
specific prior written permission.  

 

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE.

http://www.freertos.org/
http://www.savannah.nongnu.org/
http://www.freertos.org/
http://www.savannah.nongnu.org/
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